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1 Общие положения 
 

Программа итоговой аттестации дополнительной профессиональной программы 
«Дизайнер-верстальщик. Профессиональная верстка в Adobe Photoshop, Illustrator, 
InDesign» в сфере деятельности: Графический дизайн, разработана на основе Положения 
об итоговой аттестации слушателей, обучающихся по программам дополнительного 
профессионального образования ОЧУ «Специалист». 

Итоговая аттестация представляет собой форму оценки степени и уровня освоения 
обучающимися образовательной программы. Итоговая аттестация проводится на основе 
принципов объективности и независимости оценки качества подготовки обучающихся.  

Итоговая аттестация является обязательной для слушателей, завершающих 
обучение по дополнительной профессиональной программе профессиональной 
переподготовки.   

К итоговой аттестации допускается слушатель, не имеющий задолженности и в 
полном объеме выполнивший учебный план по ДПП. 

Итоговая аттестация слушателей проводится с целью установления соответствия 
достигнутых результатов освоения ДПП заявленным целям и запланированным 
результатом обучения. 

Итоговая аттестация по программе профессиональной переподготовки проводится 
в форме итогового экзамена (в том числе в форме тестирования) и/или защиты итоговой 
аттестационной работы/проекта в соответствии с программой профессиональной 
переподготовки. Видом итоговой аттестации выпускников по ДПП программе 
профессиональной переподготовки «Дизайнер-верстальщик. Профессиональная верстка в 
Adobe Photoshop, Illustrator, InDesign», сфера деятельности «Графический дизайн» 
является тест.  

При применении итоговых аттестационных испытаний с применением 
электронного обучения, дистанционных образовательных технологий обеспечивается 
идентификация личности слушателя и контроль соблюдения установленных учебным 
планом и настоящим положением норм и требований. 

Слушателям, не прошедшим итоговую аттестацию или прервавшим обучение по 
уважительным причинам (по медицинским показаниям, подтвержденным 
соответствующими документами), предоставляется возможность переноса срока 
прохождения итоговой аттестации на основе личного заявления. В случае если слушатель 
был направлен на обучение организацией, данный вопрос согласовывается с данной 
организацией. 

 
2. Виды и задачи профессиональной деятельности выпускников 

 
Виды и задачи профессиональной деятельности выпускников, заявленные в 

программе «Дизайнер-верстальщик. Профессиональная верстка в Adobe Photoshop, 
Illustrator, InDesign» (сфера деятельности «Графический дизайн»): художественная, 
проектная, информационно-технологическая.  

Вид трудовой деятельности – 1) Дизайн объектов и систем визуальной 
информации, идентификации и коммуникации, квалификационный уровень – шестой; 
дополнительно - 2) Производство продукции печатных средств массовой информации. 
Для выполнения работ по решению практических задач, требующих самостоятельного 
анализа ситуации и ее изменений: 1) Художественно-техническая разработка дизайн-
проектов объектов визуальной информации, идентификации и коммуникации. 2) 
Предметная реализация требований к художественно-техническому оформлению СМИ. 
Возможное место работы (типы предприятий): коммерческие и некоммерческие 
организации. 
Задачи профессиональной переподготовки: совершенствование имеющихся и 
формирование новых компетенций у обучающихся для выполнения трудовых функций: 
B/02.6,  А/01.7, А/02.7, А/03.7 
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Трудовые функции согласно  
1) профстандарту «Графический дизайнер» (Утвержден приказом Министерства 

труда и социальной защиты Российской Федерации от 17 января 2017 года N 40н): 
 Проектирование объектов визуальной информации, идентификации и коммуникации 
2) Специалист по производству продукции печатных средств массовой информации», 

утвержденного приказом Минтруда и социальной защиты РФ от 04.08.2014 N 533н: 
 Предметная реализация требований к художественно-техническому оформлению 

СМИ 
Разработка макета издания 
Отбор иллюстративных материалов 
Заказ печати тиража и прием выполненной работы 

 
 

3. Требования к результатам освоения программы для выполнения 
профессиональных (трудовых) функций 

 
Результатом освоения дополнительной профессиональной программы является 

развитие общекультурных, общепрофессиональных и формирование профессиональных 
компетенций. В частности, совершенствование имеющихся компетенций:   

 
 способностью владеть рисунком и приемами работы, с обоснованием 

художественного замысла дизайн-проекта, в макетировании и моделировании, с 
цветом и цветовыми композициями (ПК-1); 

 способностью обосновать свои предложения при разработке проектной идеи, 
основанной на концептуальном, творческом подходе к решению дизайнерской 
задачи (ПК-2); 
способностью учитывать при разработке художественного замысла особенности 

материалов с учетом их формообразующих свойств (ПК-3); 
 способностью анализировать и определять требования к дизайн-проекту и 

синтезировать набор возможных решений задачи или подходов к выполнению 
дизайн-проекта (ПК-4); 

 способностью применять современные технологии, требуемые при реализации 
дизайн-проекта на практике (ПК-6); 

 способностью выполнять эталонные образцы объекта дизайна или его отдельные 
элементы в макете, материале (ПК-7); 
способностью разрабатывать конструкцию изделия с учетом технологий 

изготовления: выполнять технические чертежи, разрабатывать 
технологическую карту исполнения дизайн-проекта (ПК-8); 
способностью использовать информационные ресурсы: современные 

информационные технологии и графические редакторы для реализации и создания 
документации по дизайн-проектам (ПК-10); 

 
Декомпозиция вышеназванных компетенций на уровне уметь, знать представлена в 

картах компетенций программы профессиональной переподготовки. 
 
4. Требования к выпускнику, проверяемые в ходе итогового аттестации 

 
Итоговая аттестация предполагает проверку результатов освоения программы 

профессиональной переподготовки, т.е. оценку сформированности всех компетенций, 
предусмотренных программой.   

Аттестация по ДПП ««Дизайнер-верстальщик. Профессиональная верстка в Adobe 
Photoshop, Illustrator, InDesign»» осуществляется в форме защиты проекта/тестирования. 

Подготовка выпускного проекта включает: 
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─ Индивидуальный проект; 
─ Презентацию проекта. 
В момент поступления на обучение по программе профессиональной 

переподготовки, обучающемуся предоставляется для ознакомления учебный план, 
расписание учебных занятий, требования к освоению учебных дисциплин, форма 
итоговой аттестации.  

К итоговой аттестации допускаются обучающиеся, выполнившие учебный план в 
полном объеме, не имеющие академическую задолженность (задолженность по текущей и 
промежуточной аттестации).  

При прохождении итоговой аттестации выпускники должны показать свою 
способность и умение, опираясь на полученные знания, сформированные умения, 
профессиональные компетенции, самостоятельно решать на современном уровне задачи 
своей профессиональной деятельности, профессионально излагать специальную 
информацию, аргументировать и защищать свою точку зрения. 

Оценка выставляется в соответствии с критериями, приведенными в п. 7 настоящей 
программы по принятой четырех балльной системе. Итоговая оценка определяется по 
окончанию итогового экзамена. По окончании заседания результаты объявляются 
Председателем аттестационной комиссии.  

По результатам аттестационных испытаний обучающийся имеет право на 
апелляцию 

 
5. Порядок формирования и состав аттестационной комиссии 
 
Итоговая аттестационная комиссия создаётся в целях комплексной оценки уровня 

знаний слушателей с учетом целей обучения, вида ДПП, установленных требований к 
содержанию ДПП, результатов промежуточных испытаний. 

Аттестационную комиссию по ДПП возглавляет председатель. Председателем 
может быть лицо, не работающее в образовательной организации, из числа ведущих 
специалистов предприятий, организаций, учреждений, научно-педагогических работников 
сторонних образовательных организаций. Председатель комиссии контролирует её 
деятельность, обеспечивает единство требований, предъявляемых к слушателю. 

Аттестационная комиссия формируется из представителей работодателей, 
преподавателей ОЧУ «Специалист» и преподавателей сторонних образовательных 
организаций по профилю осваиваемой слушателями программы. Количественный состав 
не должен быть меньше чем 3 человек, включая председателя, заместителя председателя 
аттестационной комиссии, секретаря. Персональный состав аттестационной комиссии 
ежегодно утверждается приказом директора. 

Дата и время проведения заседания итоговой аттестационной комиссии по ДПП 
профессиональной переподготовки устанавливается директором ОЧУ «Специалист» и 
доводится до сведения всех членов аттестационной комиссии за 14 (четырнадцать) 
календарных дней до начала итогового испытания. 

При устной форме итоговых испытаний решение аттестационной комиссией 
принимается на закрытых заседаниях простым большинством голосов членов комиссий, 
участвующих в заседании. При равном числе голосов голос председателя является 
решающим. Решение комиссий принимается непосредственно на заседании после 
оформления и подписания протокола, и сообщается слушателю. 

Результаты итоговой аттестации слушателей ДПП фиксируются в 
соответствующих документах, определяемых настоящим Положением, и хранятся в 
архиве ОЧУ «Специалист» согласно номенклатуре дел. 

Решение по результатам проведения итоговой аттестации слушателей по ДПП 
профессиональной переподготовки оформляется следующими документами: 
- протокол заседания аттестационной комиссии по приему итоговой аттестационной 
работы; 
- протокол заседания аттестационной комиссии по приему итогового экзамена; 
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- отчет о работе аттестационной комиссии (ежеквартальный). 
Итоговая аттестация ДПП профессиональной переподготовки ««Дизайнер-

верстальщик. Профессиональная верстка в Adobe Photoshop, Illustrator, InDesign» в  форме 
проекта оформляется протоколом заседания аттестационной комиссии по приему 
итоговой аттестационной работы.  

 
6. Порядок подготовки и проведения итоговой аттестации 

 
Итоговая аттестация проводится в форме защиты Индивидуального проекта, 

презентации проекта. 
Допущенная к защите аттестационная работа с рецензией руководителя, 

представляется в аттестационную комиссию не позднее, чем за 2 дня до защиты. 
Защита итоговой аттестационной работы проводится на открытом заседании 

аттестационной комиссии. Защита начинается с доклада слушателя по выполненной 
аттестационной работе, продолжительность которого не должна превышать 5-7 минут. 
Доклад должен содержать: обоснование актуальности избранной темы, описание 
исследуемой проблемы, формулировку цели и задач работы, ее наиболее важные 
результаты, выводы и основные рекомендации, имеющие прикладное значение. Для 
сопровождения доклада рекомендуется подготовить презентацию, раздаточные 
материалы. 

После завершения доклада члены аттестационной комиссии задают слушателю 
вопросы в течение 15 минут с момента окончания доклада слушателя, ответы на которые 
позволяют оценить степень владения автором предметом исследования, уровень 
сформированных компетенций, знание научной литературы по профилю исследуемых 
вопросов, умение вести научную дискуссию и т.п. При ответах на вопросы слушатель 
имеет право пользоваться своей работой. В дискуссии могут принимать участие 
присутствующие на защите слушатели. После ответов слушателя на вопросы оглашается 
рецензия и рекомендованная в ней оценка. Слушатель должен ответить на замечания 
рецензента, соглашаясь с ними или давая обоснованные возражения. 

Итоговая оценка выставляется на основе выводов руководителя, отраженных в 
рецензии, качества защиты аттестационной работы (доклад слушателя, ответы на 
замечания рецензента и вопросы членов аттестационной комиссии). 

Основными оцениваемыми показателями являются: 
-актуальность темы работы и ее выводов; 
-обоснованность результатов и выводов (соответствие их известным научным положениям и 

фактам; логичность в изложении собственных данных; корректность проведения 
эксперимента, использования научных методов исследования и т. п.); 

-определенная новизна полученных данных; 
-самостоятельность (личный вклад слушателя, который определяется степенью 

самостоятельности в выборе темы, постановке задач, планировании и организации 
исследования, обработке и осмыслении полученных результатов); 

-возможность практического использования полученных результатов; 
-аргументированность и четкость доклада слушателя на защите; 
-соответствие оформления работы установленным требованиям; 
-качество иллюстративного материала и электронной презентации к докладу. 
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17. Лин М.В. Современный дизайн. Пошаговое руководство. Техника рисования во 
всех видах дизайна: от эскиза до реального проекта: архитектура, ландшафтный 
дизайн, дизайн интерьеров, графический дизайн. /Пер. с англ. О.П.Бурмаковой. – 
М.: АСТ, Астрель, 2012. – 199 с. 

18. Лоренс Зиген. Цифровая иллюстрация: мастер-класс по креативному 
имиджмейкингу. /Пер с англ. П. Кодолова. – М.: АСТ; Астрель, 2013. - 176с.: ил. 

19. МакВейд Дж. Графика для бизнеса. / Пер. с англ. – М.: ООО «Кудиц-пресс», 2007. 
– 208с. 

20. Мещанинов А.А. Дизайн. Точка над й. – СПб.: Изд-во Политех. Ун-та, 2008. -220с. 
21. Михайлов С.М., Кулеева Л.М. Основы дизайна. Учебник. –Казань: Новое знание, 

1999. 
22. Михайлов С.М., Михайлова А.С. Основы дизайна: Книга 1. Введение в дизайн. Уч. 

пособ. – Казань: Дизайн-квартал, 2008. – 288с.: ил. 
23. Михайлов С.М., Михайлова А.С. Основы дизайна: Книга 2. Из истории дизайна. 

Уч. пособ. – Казань: Дизайн-квартал, 2008. – 288с.: ил. 
24. Наймушин А.Д. Основы организации рекламы. – М.: РПЦ «Внешторгиздат», 1992. 

– 214с.: ил. 
25. Орнаменты рукописных и старопечатных книг Башкортостана /Сост. Г.Б.Хусаинов, 

И.Г.Галяутдинов. – Уфа: Китап, 2001. – 160с.: ил. 
26. Папанек В. Дизайн для реального мира /Пер с англ. Г.Северской. – М.: 

Издательство «Д.Аронов», 2010. – 416с. 
27. Паркер Р. Как сделать красиво на бумаге /Пер с англ. В.Овчинников, В.Тимохин. – 

М.: Символ-Плюс, 2008. – 384с. – (Библиотека дизайна). 
28. Пронин С. Рекламная иллюстрация. Креативное восприятие. – М.: Бератор-Пресс, 

2003. – 144с. 
29. Пушкарева Н.В. Интерьер: 1000 практических советов. – Ростов-н/Д: Феникс, 2006. 
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– 248с.: ил. - (Мастерская). 
30. Розенсон И.А. Основы теории дизайна: учебник для вузов. – СПб.: Питер, 2007. – 

219с., ил. 
31. Рунге В.Ф. История дизайна, науки и техники. Уч. пособ. Издание из 2-х книг. 

Книга 1. – М.: Архитектура-С, 2008. – 368с.: ил. 
32. Рунге В.Ф. Эргономика и оборудование интерьера. Уч. пособ. – М.: Архитектура-

С, 2004. – 160с.: ил. 
33. Рунге В.Ф., Манусевич Ю.П. Эргономика в дизайне среды. –М: Архитектура-С, 

2005. 
34. Сазонова Е.А. Проектирование. Уч. пособ. /Под ред. В.Ф.Ахадуллина– Уфа: Изд-во 

БГПУ, 2009. – 156с.: ил. 
35. Саймондс Дж.О. Архитектура и ландшафт /пер.с анг. Меньшавина А.И. –М.: 

Издательство литературы по строительству, 1965. 
36. Семак Р.В. 3ds max 2008 для дизайна интерьеров. – СПб.: Питер, 2009. – 256с.: ил. 
37. Сикл Э. Еще больше оптических иллюзий /Пер. с англ. - М.: АСТ; Астрель, 2006. – 

167с.: ил. 
38. Смирнов С.И. Шрифт в наглядной агитации. – М.: Плакат, 1990. – 192с.: ил. 
39. Смирнов С.И. Шрифт и шрифтовой плакат. – М.: Плакат, 1981. – 144с.: ил. 
40. Соколова Т.Н. Рудская Л.А., Соколов А.Л. Архитектурные обмеры. Уч. пособ. – 

М.: Архитектура-С, 2007. – 112с.: ил. 
41. Соловьев С.А. Декоративное оформление. Уч. пособ. – М.: Просвещение, 1987. – 

144с.: ил. 
42. Старикова Ю.С. Основы дизайна. Конспект лекций. – М.: А-Приор, 2011. – 112с. 
43. Стасюк Н.Г., Киселева Т.Ю., Орлова И.Г. Основы архитектурной композиции. Уч. 

пособ. – М.: Архитектура-С, 2004. -96с.: ил. 
44. Туэмлоу Э. Графический дизайн: фирменный стиль, новейшие технологии и 

креативные идеи. – М.: АСТ; Астрель, 2006. – 256с.: ил. 
45. Уильямс Р. Недизайнерская книга о дизайне / Пер с англ. Е.В.Левченко. - СПб: 

Издательский дом «Весь», 2004. – 128с.: ил. 
46. Устин В.Б. - Учебник Дизайна. Композиция, методика, практика. -М.,2009. 
47. Устин В.Б. Художественное проектирование интерьеров. Учебник. – М.: АСТ; 

Астрель; Полиграфиздат, 2010. – 288с.: ил. 
48. Хембри Р. Самый полный справочник. Графический дизайн [Текст]. /Пер с англ. 

А.В.Банкрашкова. – М.: АСТ: Астрель, 2008. – 192с.: ил. 
49. Холмянский Л.М. Художественное конструирование. Проектирование и 

моделирование промышленных изделий: Учебник для студентов художественно-
промышленных вузов. –М.: Высш.шк., 1986. 

50. Холмянский Л.М., Щипанов А. С.  Дизайн: Книга для учащихся.— М.: 
Просвещение, 1985. 

51. Чинь, Франсис Д.К. Архитектура: форма, пространство, композиция /Пер. англ. – 
М.: АСТ; Астрель, 2010. – 432с.: ил. 

52. Чинь, Франсис Д.К. Архитектурная графика /Пер. англ. – М.: АСТ; Астрель, 2010. – 
215с.: ил. 

53. Шимко В.Т. Архитектурно-дизайнерское проектирование: Учебное пособие. –М: 
Архитектура-С, 2007. 

54. Шимко В.Т. Основы дизайна и средового проектирования. Уч. пособ. – М.: 
Архитектура-С, 2007. – 160с.: ил. 

55. Элам К. Геометрия дизайна. Пропорции и композиция. – СПб: Питер, 2011. – 112с.: 
ил 

 
Информационно-библиотечные ресурсы  

(ссылки на информационные ресурсы ОЧУ «Специалист.Ру»): 
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№ 
Наименование портала 

(издания, курса, документа) 
Ссылка 

1.  Карасева Э.В., Чумаченко И.Н. 
Рисование в Photoshop CS 

http://www.booksgid.com/graphic_design/ 

2.   Хайди Толивер-НигроТехнологии 
печати 

http://www.booksgid.com/graphic_design/ 

 
 
 

8.  Критерии оценки результатов обучения членами аттестационной комиссии 
 

   Результаты итоговой аттестации слушателей ДПП в соответствии с формой 
итоговой аттестации, установленной учебным планом, выставляются по двух бальной 
шкале («зачтено\незачтено») или четырех балльной шкале («отлично», «хорошо», 
«удовлетворительно», «неудовлетворительно»). Результаты итоговой аттестации 
заносятся в соответствующие документы.   

Результаты освоения программ профессиональной переподготовки оцениваются по 
четырёх бальной шкале в соответствии с нижеприведенными критериями: 

Отметка "неудовлетворительно" ставится, если: 
- при ответе обнаруживается отсутствие владением материалом в объеме изучаемой 
образовательной программы; 
- при раскрытии особенностей развития тех или иных профессиональных идей не 
используются материалы современных источников; 
- представление профессиональной деятельности не рассматривается в контексте 
собственного профессионального опыта, практики его организации; 
- при ответе на вопросы не дается трактовка основных понятий, при их употреблении не 
указывается авторство; 
- ответы на вопросы не имеют логически выстроенного характера, не используются такие 
мыслительные операции, как сравнение, анализ и обобщение. 

Отметка "удовлетворительно" ставится, если: 
- в ответах на вопросы при раскрытии содержания вопросов недостаточно раскрываются и 
анализируются основные противоречия и проблемы; 
- при раскрытии особенностей развития тех или иных профессиональных идей, а также 
описания профессиональной деятельности недостаточно используются материалы 
современных пособий и первоисточников, допускаются фактические ошибки; 
- представление профессиональной деятельности частично (не в полном объеме) 
рассматривается в контексте собственного профессионального опыта, практики его 
организации; 
- при ответе используется терминология и дается ее определение без ссылки на авторов 
(теоретиков и практиков); 
- ответы на вопросы не имеют логически выстроенного характера, редко используются 
такие мыслительные операции, как сравнение, анализ и обобщение; 
- личная точка зрения слушателя носит формальный характер без умения ее обосновывать 
и доказывать. 

Отметка "хорошо" ставится, если: 
- ответы на вопросы частично носят проблемный характер, при раскрытии особенностей 
развития тех или иных профессиональных идей, а также описании профессиональной 
деятельности используются материалы современных пособий и первоисточников; 
- при ответе используется терминология, соответствующая конкретному периоду развития 
теории и практики профессиональной деятельности, где определение того или иного 
понятия формулируется без знания контекста его развития в системе профессионального 
понятийного аппарата; 
- ответы на вопрос не имеют логически выстроенного характера, но используются такие 
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мыслительные операции, как сравнение, анализ и обобщение; 
- имеется личная точка зрения слушателя, основанная на фактическом и проблемном 
материале, приобретенной на лекционных, семинарских, практических занятиях и в 
результате самостоятельной работы. 

Отметка "отлично" ставится, если: 
- ответы на вопросы носят проблемный характер, при раскрытии особенностей развития 
тех или иных профессиональных идей, их описании используются материалы 
современных учебных пособий и первоисточников; 
- при ответе используется терминология, соответствующая конкретному периоду развития 
теории и практики и четко формулируется определение, основанное на понимании 
контекста из появления данного термина в системе понятийного аппарата; 
- ответы на вопрос имеют логически выстроенный характер, часто используются такие 
мыслительные операции, как сравнение, анализ и обобщение; 

- ярко выражена личная точка зрения слушателя, при обязательном владении 
фактическим и проблемным материалом, полученным на лекционных, практических, 
семинарских и в результате самостоятельной работы. 

При оценивании материалов итоговой аттестационной работы/проекта 
учитываются следующие критерии:  
- актуальность и полнота обоснования необходимости проекта; 
- аргументация позиции автора проекта с опорой на факты социально-экономической 
действительности или собственный опыт; 
- раскрытие всех элементов проекта в соответствии со структурой; 
- практическая значимость. 

 
Таблица 1. – Предмет и объект оценивания с указанием критериев и шкал 

Предмет 
оценивания 

знания, 
умения, 

владение 

Объект 
оценивания 
- продукт 

деятельност
и процесс, 
продукт и 
процесс 

Показатели 
оценки 

Критерии оценки Шкалы оценки 

Знания  
 
ПК-1 
ПК-2 
ПК-3  
ПК-4  
ПК-5  
ПК-6  
ПК-7 
ПК-8  
 

Ответ на 
вопросы 
членов 
комиссии 
или 
отсутствие 
ответов 

Актуальность 
Научность 
Полнота 
изложения 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Слушатель способен применять 
знания в широкой области 
профессиональной деятельности, 
успешно действовать на основе 
приобретенного практического 
опыта при решении общих и 
конкретных задач 

Отлично 
Компетенции 

освоены в 
полном объеме 

(100 - 90%) 

Слушатель способен применять 
знания в широкой области 
профессиональной деятельности, 
успешно действовать на основе 
приобретенного практического 
опыта при решении общих задач 

Хорошо 
Компетенции 

освоены от 66% 
до 89% 

Слушатель способен применять 
знания в ограниченной области 
профессиональной деятельности  

Удовлетворител
ьно 

Компетенции 
освоены от 50% 

до 65% 
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Слушатель не способен применять 
знания в широкой области 
профессиональной деятельности, 
успешно действовать на основе 
приобретенного практического 
опыта при решении общих задач 

Неудовлетворит
ельно 

Компетенции 
освоены меньше 

50% 

Слушатель способен применять 
знания  в широкой и ограниченной 
области профессиональной 
деятельности при решении 
теоретических и практических 
задач 

Зачтено 
Компетенции 

освоены от 50% 
и более 

 

Слушатель не способен применять 
знания в широкой области 
профессиональной деятельности 
при решении общих и конкретных 
задач 

Не зачтено 
Компетенции 

освоены меньше 
50% 

Умения 
 
ПК-1 
ПК-2 
ПК-3  
ПК-4  
ПК-5  
ПК-6  
ПК-7 
ПК-8  
 
 

Выполнени
е 
практическ
их заданий 
в период 
подготовки 
к итоговой 
защите 
работы 
 

Достижение 
планового 
результата 
 
Активность, 
инициатива, 
толерантность, 
лидерство 
 
Качество и 
полнота 
аргументов, 
умение отстоять 
свою точку 
зрения 

Слушатель способен применять 
умения в широкой области 
профессиональной деятельности, 
успешно действовать на основе 
приобретенного практического 
опыта при решении общих и 
конкретных задач 

Отлично 
Компетенции 

освоены в 
полном объеме 

(100 - 90%) 

Слушатель способен применять 
умения в широкой области 
профессиональной деятельности, 
успешно действовать на основе 
приобретенного практического 
опыта при решении общих задач 

Хорошо 
Компетенции 

освоены от 66% 
до 89% 

Слушатель способен применять 
умения в ограниченной области 
профессиональной деятельности  

Удовлетворител
ьно 

Компетенции 
освоены от 50% 

до 65% 

Слушатель не способен применять 
умения в широкой области 
профессиональной деятельности, 
успешно действовать на основе 
приобретенного практического 
опыта при решении общих задач 

Неудовлетворит
ельно 

Компетенции 
освоены меньше 

50% 

Слушатель способен применять 
умения в широкой и ограниченной 
области профессиональной 
деятельности при решении 
теоретических и практических 
задач 

Зачтено 
Компетенции 

освоены от 50% 
и более 

 



 

 

12

Слушатель не способен применять 
умения в широкой области 
профессиональной деятельности 
при решении общих и конкретных 
задач 

Не зачтено 
Компетенции 

освоены меньше 
50% 

Навыки (опыт 
деятельности) 
  
ПК-1 
ПК-2 
ПК-3  
ПК-4  
ПК-5  
ПК-6  
ПК-7 
ПК-8  
 

Использова
ние 
полученных 
знаний  в 
практическ
ой 
деятельност
и на 
предприяти
и в период 
стажировки 
и 
подготовки 
к итоговой 
защите 
работы 

Достижение 
поставленной 
цели в 
практической 
деятельности на 
предприятии (в 
организации) - 
самооценка 

Слушатель способен применять 
знания в широкой области 
профессиональной деятельности, 
успешно действовать на основе 
приобретенного практического 
опыта при решении общих и 
конкретных задач 

Отлично 
Компетенции 

освоены в 
полном объеме 

(100 - 90%) 

Слушатель способен применять 
знания в широкой области 
профессиональной деятельности, 
успешно действовать на основе 
приобретенного практического 
опыта при решении общих задач 

Хорошо 
Компетенции 

освоены от 66% 
до 89% 

Слушатель способен применять 
знания в ограниченной области 
профессиональной деятельности  

Удовлетворител
ьно 

Компетенции 
освоены от 50% 

до 65% 

Слушатель не способен применять 
знания в широкой области 
профессиональной деятельности, 
успешно действовать на основе 
приобретенного практического 
опыта при решении общих задач 

Неудовлетворит
ельно 

Компетенции 
освоены меньше 

50% 

Слушатель способен применять 
знания  в широкой и ограниченной 
области профессиональной 
деятельности при решении 
теоретических и практических 
задач 

Зачтено 
Компетенции 

освоены от 50% 
и более 

 

Слушатель не способен применять 
знания в широкой области 
профессиональной деятельности 
при решении общих и конкретных 
задач 

Не зачтено 
Компетенции 

освоены меньше 
50% 

 

ИТОГОВОЕ ТЕСТИРОВАНИЕ:
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Вопрос 1 из 20 

Отметить 

У вас есть изображение формата А4 печатного качества. Вам нужно быстро сделать его 
размером 9х13 см. Как это сделать? 

Выберите один ответ: 

 Image - Image Size 
 Выбрать инструмент Crop Tool и установить в настройках нужный размер 

обреза. После чего обрезать. 
 Image – Trim 
 File - Crop Size 

Вопрос 2 из 20 

Отметить 

Чем отличаются в работе инструменты Белая стрелка (Direct Selection) и Белая стрелка с 
плюсом (Group Selection)? 

Выберите один ответ: 

 Инструмент Group Selection используется для выделения опорных точек, 
тогда как инструмент Direct Selection используется для выделения отдельных 
объектов. 

 Инструмент Group Selection используется для выделения частей групп, тогда 
как инструмент Direct Selection используется для работы с опорными 
точками. 

 Инструмент Group Selection позволяет выделять объекты на основе заданного 
критерия (цвет, толщина линии и пр.), а инструмент Direct Selection выделяет 
элементы, входящие в группу. 

Вопрос 3 из 20 

Отметить 

Каким образом снять выделение с объекта? (2 ответа) 

Выберите несколько ответов: 

 Выбрать команду Select>Deselect. 
 Щелкнуть в свободном месте документа. 
 Щелкнуть по объекту. 
 Выбрать команду Object>Expand. 

Вопрос 4 из 20 

Отметить 

Какие существуют способы деформации объектов через команду Envelop Distort? (3 
ответа) 
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Выберите несколько ответов: 

 По форме объекта, расположенного наверху (Make with Top Object). 
 На основе сетки (Make with Mesh). 
 На основе градиентной сетки (Gradient Mesh). 
 На основе стандартных заготовленных форм (Make with Warp). 

Вопрос 5 из 20 

Отметить 

Вы пользуетесь инструментом штамп. Какая клавиша отвечает за выбор образца 
клонирования? 

Выберите один ответ: 

 SHIFT 
 ALT 
 CTRL 
 CTRL + ALT 

Вопрос 6 из 20 

Отметить 

Как создать копию объекта? (2 ответа) 

Выберите несколько ответов: 

 Дважды щелкнуть по объекту. 
 Выделить объект и нажать кнопку Copy в панели инструментов. 
 Выделить объект и сместить его, удерживая клавишу <b>Alt</b>. 
 Выделить объект, и выполнить команды Edit>Copy, Edit>Paste (или заменить 

их нажатием горячих клавиш). 

Вопрос 7 из 20 

Отметить 

Через палитру Links всегда можно…(2 ответа) 

Выберите несколько ответов: 

 Узнать, где на диске лежит файл с изображением. 
 Отследить, не перемещен ли файл с изображением? 
 Вставить изображения в рабочий документ. 
 Изменить цветовую модель любого изображения. 

Вопрос 8 из 20 

Отметить 

Что происходит c растровым изображением, при изменении размера фрейма с помощью 
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инструмента Черная стрелка (Selection)? 

Выберите один ответ: 

 Количество пикселей в растровом изображении уменьшается или 
увеличивается. 

 Изображение остается неизменным, меняется только размер фрейма, внутри 
которого оно находится. 

 Размер фрейма не меняется, изменяется только размер растрового 
изображения внутри него. 

Вопрос 9 из 20 

Отметить 

Что означает появление иконки в виде треугольника с восклицательным знаком в палитре 
Links? 

 

Выберите один ответ: 

 Связь с изображением разорвана, Adobe InDesign не располагает 
информацией о том, где находится данный файл. 

 Изображение было отредактировано после помещения в Adobe InDesign. 
 Изображение было внедрено. 
 Файл с изображением сохранен в неизвестном для Adobe InDesign 

графическом формате. 

Вопрос 10 из 20 

Отметить 

Вы хотите трансформировать текстовый слой. Какой вид трансформации не доступен для 
применения к текстовому слою? 

Выберите один ответ: 
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 Scale 
 Warp 
 Skew 
 Distort 

Вопрос 11 из 20 

Отметить 

Вы сделали выделение и хотите растушевать его границы. Как это сделать? 

Выберите один ответ: 

 Поставить в настройках инструмента в значении Feather нужное количество 
пикселей 

 Включить Refine Edge и поставить в значении Smooth требуемое количество 
пикселей 

 Выполнить команду Select – Modify – Feather 
 Выполнить команду Select – Glow 

Вопрос 12 из 20 

Отметить 

Какой режим наложения используется при имитации света? 

Выберите один ответ: 

 Screen 
 Overlay 
 Color 
 Multiply 

Вопрос 13 из 20 

Отметить 

Какие режимы отображения графики использует Adobe InDesign? (2 ответа) 

Выберите несколько ответов: 

 Fast Display – режим просмотра верстки без картинок. 
 Graphic Only – режим просмотра только графики, без текста. 
 Typical Display – режим просмотра, в котором вся графика показывается с 

пониженным качеством. 
 Business Graphics – режим показа таблиц и диаграмм. 

Вопрос 14 из 20 

Отметить 

Как можно задать радиальный тип градиента при использовании инструмента Gradient 
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Feather? 

 

Выберите один ответ: 

 Через палитру Gradient. 
 Через меню Object⇒Effects⇒Gradient Feather. 
 Через меню Object⇒Corner Options⇒Rounded. 

Вопрос 15 из 20 

Отметить 

Какой эффект нужно применить, чтобы придать ему рельеф? 

Выберите один ответ: 

 Satin 
 Bevel & Emboss 
 Drop Shadow 
 Inner Glow 

Вопрос 16 из 20 

Отметить 

Как нарисовать треугольник? 

Выберите один ответ: 

 Указать в настройках инструмента Прямоугольник (Rectangle) количество 
сторон – 3. 

 Указать в настройках инструмента Многоугольник (Polygon) количество 
сторон – 3. 

 Создать прямоугольник и у него удалить одну из сторон, это автоматически 
привет к превращению фигуры в треугольник. 
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 Воспользоваться специальным инструментом Треугольник (Triangle). 

Вопрос 17 из 20 

Отметить 

Каким образом можно перемещаться по рабочей области документа? (2 ответа) 

Выберите несколько ответов: 

 С помощью команды Jump to и указанием X и Y координат нужного места. 
 С помощью инструмента Ладошка (Hand). 
 С помощью горячих клавиш <b>Ctrl</b> или <b>Cmd —</b>. 
 Удерживая в нажатом состоянии клавишу Пробел. 

Вопрос 18 из 20 

Отметить 

Можно ли в градиент включить образец узора (pattern)? 

Выберите один ответ: 

 Да 
 Нет 

Вопрос 19 из 20 

Отметить 

Какое основное преимущество использования любых графических планшетов перед 
мышью? 

Выберите один ответ: 

 Регулировка размера рабочей области на экране 
 Точность позиционирования 
 Чувствительность к нажатию 
 Возможность беспроводного использования 

Вопрос 20 из 20 

Отметить 

Какой минимальной толщины может быть создана линия в программе Adobe Illustartor? 

Выберите один ответ: 

 1 pt. 
 0.5 pt. 
 0.25 pt. 
 Нет ограничения на минимальную величину линии, но в списке готовых 

значений в палитре Stroke, 0,25 pt самое маленькое значение. 


